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1 Introduction 
 

EasyTRA calculates the risk for human health and environment of a substance use based on 

substance specific data and exposure estimates as required under REACH. EasyTRA uses a tiered 

approach known as "Targeted Risk Assessment". Starting with very restrictive default assumptions for 

exposure calculation, it is possible to modify conditions in several tiers and thereby achieve an 

approximation to the actual exposure situation.  

 

EasyTRA is based on the ECHA prescribed “Use Descriptor” system in terms of construction and 

content. This system is currently only available in English; there are no official translations into other 

official European languages by ECHA as yet.  

In order to avoid future compatibility problems with ECHA’s systems, the terms used in the EasyTRA 

use descriptors are available exclusively in English. 

 

Therefore, it is recommended to familiarize yourself with the REACH descriptor system prior to 

studying the EasyTRA manual. In Chapter D.4.3 of the ECHA “Guidance Information Requirements 

and Chemicals Safety Assessment (Part D): Exposure Scenario Building”, you will find the necessary 

explanations for the terminology used for the descriptor system in EasyTRA.  

 

EasyTRA uses algorithms on the basis of the latest versions of the ECHA REACH Guidance chapters 

R12, R13, R14, R15, and R16 (as of March 2010) and EUSES®. EasyTRA works in compliance with 

ECETOC® Targeted Risk Assessment 2010 (as of April 2010) for the calculation of worker and 

consumer exposure and complies with EU TGD 2003 Risk Assessment Spreadsheet Model 1.24a for 

the calculation of environmental exposure (see ECHA REACH Guidance chapter R16.6.2 ). EasyTRA 

delivers results in accordance with these ECHA-accepted simulation tools at the Tier 1 level. 

Programming errors in ECETOC® TRA 2010 (as of April 2010) and known to us have been corrected 

in EasyTRA. Therefore, occasional deviations in the results generated with ECETOC ® TRA 2010 (as 

of April 2010) and those generated with EasyTRA may occur. These known errors are documented 

accordingly in Appendix III of the EasyTRA report (see chapter 6).  

 

Exposure scenarios for gases . cannot be calculated in EasyTRA.  
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2 Installation 

2.1 Hardware and Software Requirements 

2.4.2 Hardware Requirements: 

• CPU minimum 2-GHz  
• Minimum of 1 GB RAM 

2.4.2 Software Requirements: 

• Operating system: Windows XP or Linux with 2.6er Kernel 
• Java Runtime Environment (JRE) minimum Version 1.6 
 
• For the operation in the “Expert” mode, you will also require:  

o minimum IUCLID 5.2 with installed WebServices (see http://iuclid.eu for the installation 
WebServices) 

2.2 Software Installation  

After downloading the software installer from the 

easyTRA website(http://www.easytra.de), you can 

start it immediately via the file setup_easytra.exe. 

The installer installs the application in a file 

designated by you and creates a link to the start 

menu and/or desktop.  In order to use all 
functions, you must then select a license file 
under the menu “Tools” -> “Options” as 
easyTRA will otherwise only run the trial version 
and will not provide, among others, the “Save” function as well as the “Print” function.  

After the installation has been completed, you can start EasyTRA directly via the created links.  
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3 Functions 
 

3.1 General 
 
The program contains help texts for many EasyTRA functions. By clicking the question mark 
symbol , you will access the corresponding help function. 
 
• Entering Data in Tables  

 
New data is entered in tables via the last empty line. As soon as data is entered in a line, EasyTRA 

immediately creates a new empty line for further entries. 

 

 
  
 

In many columns of a table you can enter identical entries into already existing scenarios by 

doubleclicking on the grey title field. Entries made into the window, which then opens, will be 

transferred identically to all scenarios in the individual input masks. In windows with multiple selection 

options, only those new entries will be attached to or existing entries will be overwritten in all scenarios 

if they have been selected. All other existing entries remain unchanged. If you would like to only fill in  

the empty fields in the column with the corresponding entry value, activate the box ‘Fill in empty fields 

only”. Before double-clicking the header line, you may, however, also select one or more scenarios 

and selectively fill them using the function “overwrite only selected”. 

Columns which cannot be filled in conjunction with others are dependent upon entries made in other 

areas of the input module, which is why this function makes no sense in these columns. The columns 

called “RCR” cannot be actively filled in as these fields are only calculated. 

Every column of the tables can be sorted in ascending or declining order by 

right-clicking the mouse on the header line and selecting the direction 

desired. 

You can, however, also move individual scenarios within a table by drag-and-

drop. 

 

• Copying and Deleting Entries  
 

Every table in EasyTRA provides a “Copy” and “Delete” function via a context menu. Select one or 

more lines using the cursor and “Shift” key and then right-click the mouse to activate the context 

menu. The selected lines can now be copied or deleted. Copied lines are automatically entered at the 
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end of the table and can now be modified. By this method you can create and calculate many different 

scenarios of similar content in parallel. 

You may, of course, copy scenarios with 

CTRL+c and enter them as copies into the 

table with CTRL+v. This also functions for 

copying one or more scenarios from one data 

set to another, or from EasyTRA to Excel.   

If you would like to import entire sets of scenarios from other data records, you can also do this via the 

“Import” function in the menu “File”.  

 

 “Standard” Mode 

The following functions in the program are available via the menus:  
• File → New case  

Creates a new case. The existing entries are deleted and an empty input window is provided. 

 
• File → Open  

Opens an existing TRA file. The current entries are replaced.  
 
• File → Save  

Saves the current case. New cases require new file names.  

• File → Save as  

Saves the current case in a new TRA file. The old file remains unchanged.  

 
• File → Import 

To automate the entry of data, data 

from external sources can be 

imported.   

The source data can be from, e.g. 

other TRA files. The source data 

can come from, for example, other 

EasyTRA files. However, standard 

scenarios in an Excel format, as 

provided by several European 

associations (e.g. 

www.duccplatform.org) can also be 

imported. These must, however, be 

available in a fixed format to enable EasyTRA to import them correctly. On the EasyTRA 
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website (http://www.easytra.com) you can download an excel example file in the correct 

EasyTRA format. This example file can be filled with your own entries or used as a template for 

the modification of external data records.  

When using external data records, ensure that all table headers (as in the example file) are in 

English and only use EasyTRA compatible selection criteria. If only digits are found in the field 

“duration and frequency”, they will be evaluated as minutes/day and imported as “Tier 2” “ 

settings (see “Tier 2 Settings”).   

The import function enables the aggregation of relevant calculation data in order to minimize the 

number of of scenarios. In this case, those scenarios, which can only be differentiated by data 

that is not relevant for calculations, are automatically summarized (e.g. in the case description). 

All titles of all aggregated scenarios are consolidated in the “description of use” field. Caution! 
Do not aggregate scenarios if you intend to export scenarios to IUCLID 5.2 as the titles of 
environmental scenarios and matching human health scenarios  must be identical in 
order to guarantee correct linking. 

The import function allows you to select the type of scenarios you would like to import: Worker 

scenarios, Consumer scenarios, Environmental scenarios or a combination of these. If you wish, 

you can furthermore import the “Sector of Use” (see Chapter 5.1 Header Data) with the 

scenarios.  

When importing Excel files, select the import file via “Browse“ and select the data sheet from the 

excel files that you would like to import. When importing TRA files, you must select the revision 

from which you would like to import,  

If possible, the title of the source file should be English in order to make it possible for third 

parties to identify the basis for the TRA calculation. All imported Tier 2 settings in the source file 

are stored in EasyTRA and referenced by naming the source file in the “justification”for Tier 2 

changes field. The name of the source file is also transferred to the documentation in the 

EasyTRA report. Therefore, useful names for the source files are  e.g. “AISE consumer 

exposure scenarios as of March 12 2010.xls“. Additional information on source files and 

authorship can also however be given (in English) in the “Justification Text for Tier 2 Settings” 

(see below).  

Some industry associations have not included life cycle information to their DUCC files as as all 

scenarios refer only to consumer scenarios. If you would not like to add the life cycle information 

individually to your scenarios later, you can automate the allocation by selecting“manually 

allocate Product Categories to the life cycle category “Consumer”.  
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When importing scenarios, you may preset the standard efficacy for gloves for all imported 

scenarios. 

By clicking “Advanced”, you can still carry out certain presettings which will simplify the import of 

several associated scenarios. 

 

Several associations  enter exposure duration as a product of frequency and duration. If you 

activate the corresponding box, EasyTRA multiplies these values in minutes/days directly during 

import. Information on life cycles in environmetnal scenarios is often missing in association 

tables. If you would like to automatically link fields to the life-cycle “Final Use”, activate the 

corresponding box. The box “Numerical Values” can be actiivated if there are only figures 

available in the descriptor fields but the descriptor type is missing. This is then added via the 

corresponding column name by EasyTRA. The last box is activated if you would like to transfer 

the contents of the column “Short description of process activity” of the DUCC format into the 

field “Subtitles” of EasyTRA. This enables you to steer the structure of the CSR as “contributing 

scenarios” in CSR are only bundled via the scenario name but not via the subtitle (see ECHA 

guidelines for information requirements and substance safety – exposure scenario format D 

2.2.2). 

A number of product categories (PC) and article categories (AC) are not filed as defaults in 

EasyTRA. If the box “Import Non-calculable PCs or ACs as User-Defined” is activated, you may 

later link these categories to your user-defined PCs or ACs. 

The justification text entered into the field is used for all Tier 2 justifications which are used by 

the imported data set, and this information is also used in both the CSR and EasyTRA report. As 

the working language of ECHA (and therefore the CSR) is English, you must also write the 

justification text in English. It is highly recommended to enter exact source information into this 

field to enable the Evaluator of your dossier to verify it. Sensible information in this field are, e.g.:  

the exact title of the source file and the date of entry of the source file. You may, however, also 

choose different helpful justification texts. 
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• Report → Generate Report  
Calculates the entered scenarios and generates a TRA Report with the results, corresponding 

entry data and defaults as well as the formulas used for the calculations. The report can be 

printed immediately or saved as a PDF file (see Chapter 6 TRA Report).  

• Report → Report Settings  
Sets the output language for reports. 

The output language is independent of 

the language setting of the user 

interface. It is also possible to specify 

a company logo to be printed on the report header. 

 

 

• Tools→ Options  
Via this menu, you can select the language 

of the user interface, links to the used 

license file and (depending on the license) 

the link to the permanent directory for user-

defined data.  

• View 
EasyTRA enables the view and entry of number values in decimal formats (e.g. 0.04) as well as 

in scientific formats (4E-2). In the menu “View”, you can alternate between these two View/Entry 

formats. 

The simultaneous calculation of the risk characterization ratio  can also be activated or 

deactivated in the menu “View”. 

. 
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4 Basis for EasyTRA Risk Assessment 
 
 

EasyTRA calculates the risk of substance usage for humans and the environment on the basis of a 

comparison of reference values such as Derived No Effect Levels (DNEL) and Predicted No Effect 

Concentrations (PNEC) and the corresponding exposure scenarios for humans and the environment, 

which are deduced from the selected exposure scenarios. While the reference values are defined 

characteristics of the substance to be assessed, the exposure scenarios can be modified within the 

scope of possibilities in EasyTRA. EasyTRA makes use of a two-step approach.  

The first step (Tier 1) involves using very conservative accepted defaults (TRA default values), which 

have been agreed upon by ECHA, the European chemical industry and the EU member states. Easy 

TRA uses algorithms on the basis of the latest versions of the ECHA REACH Guidance chapters R12, 

R14, R15, and R16 (as of March 2010) and EUSES®. EasyTRA works in compliance with ECETOC® 

Targeted Risk Assessment 2010 (as of April 2010) for the calculation of worker and consumer 

exposure and complies with EU TGD 2003 Risk Assessment Spreadsheet Model 1.24a for the 

calculation of environmental exposure (see ECHA REACH Guidance chapter R16.6.2 ). EasyTRA 

delivers results in accordance with these ECHA-accepted simulation programs at Tier 1 level. 

Programming errors in ECETOC® TRA 2010 (as of April 2010) known to us have been corrected in 

EasyTRA. Therefore, occasional deviations in the results generated with ECETOC ® TRA 2010 and 

those generated with EasyTRA may occur. The errors known to us are documented accordingly in 

Appendix III of the EasyTRA report (see chapter 6). 

 

These Tier 1 defaults may possibly be too restrictive in practice or for your special exposure scenario. 

For these reasons, EasyTra enables the refinement of the accepted defaults for realistic exposures in 

a second step (Tier 2), or for further refinement, Tier 3 (currently only available for environmental 

assessment). 

 

The following will describe the data necessary for a calculation in Tier 1 TRA and the available 

modification options in Tier 2 or Tier 3 of the input module.  

 

It is recommended that you familiarize yourself with the REACH use descriptor system before entering 

scenarios in EasyTRA. In Chapter D.4.3 of ECHA’s “Guidance Information Requirements and 

Chemical Safety Assessment (Part D): Exposure Scenario Building”, you will find the necessary 

explanations of the terminology used in the descriptor system in EasyTRA. 
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The starting point for the calculation of exposure scenarios should always be typical application 

conditions and not extreme cases. It is important that the application be “identified” in the appendix of 

the safety data sheet (Article 31 REACH Regulations), which is only possible if the application is safe. 

You can identify safe appilcations as the fields in the “RCR”  columns for the individual 

compartments/routes are highlighted in green  “RCR” stands for Risk Characterization Ratio and 

refers to the ratio of the daily dosage/concentration and the actual exposure of a substance. 

 
If, in a given case, a downstream user makes use of your substance under extreme boundary 

conditions that deviate from your TRA application conditions in one or more points, the downstream 

user may calculate his own scenario using his own extreme case (Article 37 REACH Regulations). 

Should the extreme case remain safe, the downstream user must only document this (e.g. with 

EasyTRA) and has no further obligations. This is, however, only possible if the use is identified in the 

extended safety data sheet. If the use is not identified, the downstream user has no alternative but to 

ask the producer to enter his scenario in the extended data safety sheet, and he must calculate the 

scenario completely on his own and must officially inform ECHA. It is, therefore, in the interest of the 

producer to identify as many uses as possible.  

 

It is recommended to use the English language for exposure titles and all free texts, such as 

justifications for the deviation from default assumptions if you intend to generate chapters 9 and 10 of 

the Chemical Safety Report (CSR) with EasyTRA. According to ECHA, Chemical Safety Reports must 

be submitted to ECHA in English.  
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5 Structure of the Input Modules 
 

The input module comprises a total of 5 input masks: Header data, physical-chemical characteristics, 

worker exposure, consumer exposure and environmental exposure, which can be found under the 

corresponding tabs. In the following chapters, you will find information on the data you can enter in the 

input masks and how this will influence the individual risk calculation.  

 

Data fields that are 

required for the risk 

calculation are high-

lighted in yellow.  

 

A TRA Report can only be generated if the yellow fields are filled in. 
 

Depending on the scenarios to be calculated, additional 

data may be necessary. Should any of this data be 

overlooked, a message will automatically appear and the 

program will request you to fill in the missing data.  

 
 
At the same time, the incomplete data field will be 

highlighted in red.  

 

All the data entered in the input modules is output in the 

TRA Report (see Chapter 6) and enables the reader to reconstruct every step.  

5.1 Header Data 
 

Header data identifies the substance to be assessed. In the “General Description” field you can enter 

a free text which you find appropriate. In the “Substance Name” field you must identify the substance. 

It is recommended to enter further indicative references in addition to the name, such as CAS 

numbers and EC numbers (EINECS). 

 

The “Sector of Use“ is 

data derived from the 

ECHA “Guidance 

Information 

Requirements and Chemicals Safety Assessment (Part D): Exposure Scenario Building”. It describes 
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the relevant industrial sector for your exposure scenario. You can select a single sector or also several 

sectors, depending on the extent to which your substance is used. The sector of use plays no role in 

the assessment but the data may help you to maintain an overview. 

 

The “General Description” field offers you the opportunity to enter further information to describe the 

case.  

  

5.2 Physical-Chemical Data 
 

The input mask “Physical-Chemical” requires the following data:   

- Molecular weight 

- Vapor pressure 

- Water solubility 

- Partition coefficient octanol/water 

 
 
The correct units must be observed when entering the 

information. For very small or very large values, a scientific 

input format (see Chapter 3.2 “Standard Functions”) is 

recommended. Maintaining all “voluntary” parameters in the 

header data is also recommended as unfavorable defaults 

may otherwise be made by the system.  

 

Vapor pressure for solids must also be entered. 

 

For non-volatile substances without measured values, the value 0.00001 Pa may be entered. The zero 

value is not permitted. 

 

5.3 Human Health Assessment Workers 
 

The input mask “Human Health Assessment Workers” enables you to calculate a worker’s exposure 

during work with the help of simple defaults. 

 

Select the most descriptive name possible for your scenario under “Scenario name”. The number of 

scenarios can become quite large in time, which may make it difficult for you to maintain an overview. 

The “Scenario Code” can also be of help as there scenario codes available in many associated 
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scenarios. If associated scenarios are imported using a code, the field will be filled automatically (see 

chapter 3.1).  

 

 
 

The “Subtitle” are especially suited to differentiate between various scenarios or so-called “contributing 

scenarios” (see chapter 5.6). While the superordinate environment scenarios are linked via the worker 

scenarios using the same name and therefore fulfill an important funtion in EasyTRA, the subtitles 

serve to enable a clear and distinct description of a scenario. 

In Chapter D.4.3 of the ECHA “Guidance Information Requirements and Chemicals Safety 

Assessment (Part D): Exposure Scenario Building”, you will find the necessary explanations for the 

term “Process Category. As there are currently no official translations of process categories, these are 

currently only available in English in EasyTRA. 

This mainly deals with a categorized description of industrial and professional processes which cover 

all defaults. Select a process category  which best describes your substance use (e.g. “Used in a 

Closed Process, No Likelihood of Exposure”). In rare cases, your special application may not be 

available as a process category. If none of the available categories are appropriate for your 

application, it may not be possible to calculate this process category with EasyTRA.  

 

Under “Type of Setting”, you can choose whether the application takes place in either the professional 

or industrial sector. This setting will have an effect upon the exposure defaults.  

 

In the case of a solid substance, the checkbox “Solid”  must be selected, and then the grade of 

dustiness during processing must be entered. The dustiness is subdivided into three general 

categories that are classified as follows:  

 

Dustiness During 
Process  

Examples 

Low Pellets, Granulate  
Medium Sugar, Salt  
High Flour, Talcum 

 
When in doubt, select the dustier category for your substance.  
 
The grade of dustiness directly affects inhaled and dermal exposure. To minimize the exposure to 

solid substances, for example, ventilation, respiratory protection and/or the use of gloves can be 

included (Tier 2, see below). 
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The duration of the activity is also categorized:  
 

Duration of the 
Activity 

Underlying Factor 
(Default Setting) 

> 4 Hours 8 Hours 
1-4 Hours 4.8 Hours 
15 Minutes - 1 Hour 1.6 Hours 
< 15 Minutes 0.8 Hours 

 
To begin with, the typical duration of the activity and not the extreme case should always be selected, 

as additional safety factors are already saved in the standard algorithms for the activity duration. 

 

Three different scenarios can be selected in the “Use of Ventilation” field:  

- Outdoors 
- Indoors without LEV 
- Indoors with LEV 

 
These scenarios are based on certain defaults. Modification (Tier 2) has not been provided for at 

present.  

 

Two different effectivity percentages can be selected in the “Use of Respiratory Protection” field; either 

90% or 95% efficiency. The efficiency is then directly integrated into the TRA exposure calculation.  

 

“Substance in Preparation?”  is standardly subdivided into 4 categories: 

 
Category Underlying Factor 

(Default Setting) 
<1% 10% 
1-5% 20% 
5-25%  60% 
> 25% 100% 

 
These categories for the assessment of raw materials in which a certain amount of flexibility is given in 

the selection of formulas, should normally suffice. If you would like to enter a specific application 

concentration for your special application instead of the category’s standard options, you can have the 

modified scenario calculated by “Tier 2” (see next chapter)  under certain circumstances..  

 
When you evaluate a solid, the function “Substance in Preparation?“ is standardly disabled. However, 

you can also enter formula data for solids in the “Tier 2” module and have it calculated. 

 

Mandatory fields in the input 

mask “Workers” are 

reference values on whose 

basis the workplace exposure is calculated. Reference values are normally DNELs on the basis of 
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animal test data (Chapter B7 ECHA Guidance on Information Requirements and Chemical Safety 

Assessment Part B: Hazard Assessment). EasyTRA also enables the selection of other reference 

values, e.g. on the basis of existing legal occupational exposure limit values (OELV). In TRA 

calculations, every entered value is included and documented in the TRA Report. This provides third 

parties with optimal traceability of the assessment.  

 

Please ensure that the correct reference units for inhalation are selected. 

 

As it can be assumed that no intentional or foreseeable oral exposure at the workplace occurs, the risk 

assessment of the workplace thus requires no oral reference value. 

 

You can identify safe appilcations as the fields in the “RCR”  columns for the individual 

compartments/routes are highlighted in green  “RCR” stands for Risk Characterization Ratio and 

refers to the ratio of the daily dosage/concentration and the actual exposure of a substance. These 

fields are calculated simultaneously as soon as you enter the minimum required data for the scenario. 

If the fields are highlighted inre, your scenario is not safe according to the slected conditions and you 

must either set Tier 2 conditions (see chapter 5.3.1) or the scenario in CSR cannot be designated as 

safe. 

Please observe that EasyTRA creates the total risk characterization 

ratio, RCR, from the sum of RCRdermal and RCRinhalation. This 

calculation method complies with the ECHA “Guidance on 

information requirements and chemical safety assessment 

Appendix to Part F: SR Template” but deviates from the algorithm 

that ECETOC TRA uses. The results of EasyTRA and ECETOC TRA are therefore not identical here. 

5.4.2 Tier 2 Settings 
 

The button  can be found at the end of every line of the “Workers” input mask. This button only 

appears if at least one field of the scenario has been filled in. In order to carry out a Tier 2 calculation 

which deviates from defaults, a further input field can be opened with the help of this button. If the Tier 

2 settings have been activated, the button will turn red to make it visible directly in the scenario 

overview.  

 
After activating the box “Enable Tier 2 Extensions”, specific data can now be entered regarding the 

use of gloves, the exact duration of activity and the concentration of the substance in preparation. In 

Tier 2, the standardly blocked input of concentration of the substance in preparation for solids can be 

overwritten with this module.  
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The button “Use of Protective Gloves” must be selected if the use of protective gloves is to be taken 

into consideration. Therefore, the burst time of the glove material must be entered. The module 

assumes that protection is 99% until the burst time is reached and there is no protection afterwards. 

Ideally, the burst time and duration of the activity should therefore be identical. You can modify the 

effectivity of  the gloves when necessary. 

 

The function “Substance in Preparation, Exact Value, Inhalation” replaces the standard concentration 

from the concentration categories (< 1%, 1-5%, 5-25%, >25%) for the calculation of the exposure 

scenario by the entered value here. EasyTRA standardly makes calculations using higher 

concentrations than expected under the assignment of the respective category. If, for example, the 

category >25% is selected, the calculation for the inhalation exposure is, in reality, calculated using 

100% (see Chapter 5.3). This deviation is justified by the nonlinearity between the concentration in a 

solution and the corresponding concentration in the respiratory air. The excessive standard values are 

,however, only conventional and are not individually calculated thermodynamically as very many 

influencing factors must be taken into consideration. Therefore if the function “Substance in 

Preparation, Exact Value, Inhalation” is used, you must scientifically justify why your substance 

deviates from the default in preparation. A justification could, for example, be that it is a solid for 

which, of course, vapor pressure laws for liquids do not apply. A list of defaults for each concentration 

category can be found in Chapter 5.3.  
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The “Duration of Activity, Exact Value” button enables deviations from the rigid categories in Tier 1. In 

this case, the values for the average duration of the activity should be entered and not extreme values. 

If the activity does not take place on a daily basis, the data is averaged according to the total number 

of working days (e.g. 1 x per month for 10 minutes = 1/20 x 10 minutes = 0.5 minutes/day).  

 

You may also freely define specific risk management measures that are not covered by the standard 

modifications. In this case the efficiency of the measures must be defined route-by-route (dermal, 

inhalative). 

On the Tier 1 level, EasyTRA does not take into account that the concentration of the substance in 

preparation substantially influences the dermal exposure. If you would like to take the concentration 

influence into account in deviation from Tier 1 defaults, activate the button “Max. concentration in 

preparation considerations also for dermal exposure”  Then the upper  threshold value for the selected 

category will be taken into account in the calculation (e.g. selecting 5-25% will take the value 25% into 

account or selecting >25% will take the value 100%). If you know even more exact maximum 

concentrations for your preparation, you can enter these in the following field: “Substance in 

Preparation, exact value “dermal”. 

These deviations from Tier 1 defaults are noted in the EasyTRA report , and the deviating algorithms 

for calculations are documented. 

 

Important: As deviations from the defaults, which have agreed upon between ECHA, EU member 

states and the industry, occur in Tier 2, a justification must be saved as to why the use of Tier 2 

standards are possible in this case. This justification is also output in the TRA report and CSR and is a 

part of the required documentation. Therefore please only use the English language in this field. 
The justifications for the various Tier-2 measures are distributed among different tabs. 

 

5.4 Human Health Assessment Consumer 

 

The input mask “Human Health Assessment-Consumer” enables the calculation of consumer 

exposure to products and articles with the help of simple defaults.  

 

 
 
Select the most descriptive name possible for your scenario under “Scenario name” The “Scenario 

Code” can also be of help as there are scenario codes available in many associated scenarios. If 

associated scenarios are imported using a code, the field will be filled automatically (see chapter 3.1).  
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The “Subtitle” is especially suited to differentiate between various scenarios or so-called “contributing 

scenarios” (see chapter 5.6). While the superordinate environment scenarios are linked via the worker 

scenarios using the same name and therefore fulfill an important funtion in EasyTRA, the subtitles 

serve to enable a clear and distinct description of a scenario.  

 
In Chapter D.4.3 of the ECHA “Guidance Information Requirements and Chemicals Safety 

Assessment (Part D): Exposure Scenario Building” you will find the necessary explanations for the 

terminology “Product Category” (PC) and “Article Category” (AC).  

For the most part, this deals with a categorized description of consumer products and use. The 

selection is limited as not every possible consumer product is included in the catalogue and not all the 

listed entries in the ECHA Guidance Document have standardized exposure scenarios in TRA Tier 1. 

In the product or article category, the category is selected that best describes the substance use.  

Subcategories enable you to enter more detailed information for the actual application.  

If none of the listed entries describe your substance use appropriately, select “Others” in the 

product/article category and, if necessary, set up a specific scenario in Tier 2. 

 
If the product is a spray, activate the button “Is Product a Spray”. Note: Spray applications have a 

strong effect on inhalation exposure and, measures for respiratory protection are not provided for in 

EasyTRA. Therefore, according to EasyTRA, in individual cases unsafe spray applications require a 

detailed calculation by a specialist. 

 

In “Amount of Product Used per Application”, the typical amount of the substance used per application 

must be entered in grams. This data is optional. If the field is not filled in, a default value is used, 

should it be stored in Tier 1. The default values are output in the report to guarantee the transparency 

of the calculation. 

 
In “Product Ingredient Fraction by Weight” the percentage of the substance in the consumer product 

must be entered. This data is optional and will possibly be replaced by a default value, should it be 

stored in Tier 1. The default values are also output in the report. 

 
In “Skin Surface Area - Dermal” and “Skin Surface Area – Oral”, it is possible to specifically enter 

which body surfaces are exposed to the consumer product in individual cases. “Skin Surface Area – 

Dermal” applies to scenarios with adults while “Skin Surface Area – Oral” applies to infants. Not every 

consumer product is, therefore, applicable for both parameters. This data is also optional and will be 

replaced by default values 

in the calculations, should 

they be stored in Tier 1. 

 
 For the reference values  
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the same fundamentally applies as already described in the worker exposure section. In addition to 

the reference values for inhalation and dermal exposure, the oral route is also taken into consideration 

in consumer use.  

 

Please observe that EasyTRA creates the total risk characterization ratio, RCRtotal, from the sum of 

RCRdermal , RCRoral and RCRinhalation. This calculation method complies with the ECHA “Guidance on 

information requirements and chemical safety assessment Appendix to Part F:CSR Template” but 

deviates from the algorithm that ECETOC TRA uses. The results of EasyTRA and ECETOC TRA are 

therefore not identical here. 

 

5.4.1 Tier 2 Settings 
 
The button  can be found at the end of every line of the “Consumer” input mask. This button only 

appears if at least one field of the scenario has been filled in. In order to carry out a Tier 2 calculation 

which deviates from defaults, a further input field can be opened with the help of this button. If the Tier 

2 settings have been activated, the button will turn red to make it visible directly in the scenario 

overview. 
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After activating “Activate Tier 2 Extensions” on theTier 2 level, consumer exposure settings regarding 

the frequency of use of the product, use of protective gloves and the room volume can be changed. 

Further specific risk management measures can also be taken into account, whose efficiency per 

route can be freely defined. 

 

Irrespective of the information you have entered in the corresponding fields of the input mask, 

standard values for certain products or article categories are filed for the product volume used  and the 

exposed skin surface. If you would like to calculate the exposure in deviation from the standard 

values, you must activate the box “Enable overwrite of standard values”.  

 
 

Important: As deviations from the defaults, which have agreed upon between ECHA, EU member 

states and the industry, occur in Tier 2, a justification must be saved as to why the use of Tier 2 

standards are possible in this case. This justification is also output in the TRA report and CSR and  is 

a part of the required documentation. Therefore please only use the English language in this field.  

Note, that the justifications for the various Tier-2 measures are distributed among different tabs. 

 

5.4.2 User-Defined PC/AC 
 
A number of product and article categories (PC/AC) cannot be automatically calculated as there are 

no filed values with regard to the standard settings. On the EU level there has, as yet, been no 

coordination of these categories, and you must therefore possibly define the standard values yourself. 

First, select “User-defined Product and Article Categories” via “Options” in the Header. 

 

 
 

Now enter the short name, description and the assigned PC or AC category. In the description, justifiy 

the exposure conditions you will use in the following fields. Please use the English language as the 

justification will be included in the CSR and must therefore be submitted in English. 

The information regarding the exposure route refers to either adults or children and is mandatory 

along with the frequency of use and exposure time. If no exposure occurs in a route, select “None”. 

The contact surfaces of the skin are subdivided into dermal and oral exposures. The oral exposure 

only applies to children, who, for example, stick their fingers in their mouths after touching an article. 

Depending on the selected combination, you must either prescribe the layer thickness of the 

substance on the skin (adults) or a volume of swallowed substance (only children). As a point of 

reference, the EasyTRA standard layer thicknesses, which are between 0.01cm (e.g. for washing and 
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cleaning agents or wall paints) and 0.001cm (e.g. for furniture, plastic articles or shoes) can be used. 

The values filed for a swallowed volume for children are currently between 1.35g for finger paints and 

0.001g for toys. If you can verify more realistic values, you may include them accordingly in EasyTRA 

for calculations. 

 

5.5 Environmental Exposure 
 

The input mask “Environmental Assessment” enables the calculation of environmental exposures by 

manufacturing, processing and final use of the substance with the help of simple defaults. However, 

environmental exposure differs from human exposure fundamentally, as the production volume or the 

volume of use plays a decisive role.  (Input field “Tonnage”).  

 

 
 
Every consumer or worker scenario must always also be assigned an environmental scenario. The 

assignment is carried out via an identical scenario name. If you would to differentiate between 

scenario versions or contributing scenarios by title, please select only the subtitle in the category 

“Worker” or “Consumer”. 

To automatically create a missing environmental scenario for an existing consumer or worker 

scenario, select the scenario and right-click the mouse. In “Create Missing Environmental Scenario”, 

EasyTRA generates a new environmental scenario with the same titile. This serves to avoid a wrong 

assignment due to a spelling error in the title. 

 
 

While automatically generating environmental scenarios, you can also already assign a common ERC 

for all newly generated scenarios. 

EasyTRA only generates environmental scenarios for your selected worker/consumer scenarios within 

the scope of this automatic function if no corresponding ones exist. 

 

First, select the most descriptive name possible for your scenario in “Description of Use”. Many 

industrial associations (e.g. AISE, COLIPA) have already put lists of standardized scenarios on the 

Internet. EasyTRA supports these standardized scenarios via the import function (see Chapter 0) 

which will also import the “Scenario code” if provided. 
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In the column “Lifecycle Stage”, the stage of the product lifecycle to be assessed must be entered. 

EasyTRA allows you to enter any number of scenarios at this point. A registration dossier will usually 

cover the complete product lifecycle, i.e. manufacture, processing, final application and waste. In 

accordance with REACH, the stages are defined as follows:   

 
- Manufacturing of substances 
- Manufacturing of preparations, formulations 
- Final use, industrial, professional or by the consumer  
- Intentional release of substances from products  
- Waste stage 

 
If the (raw material) manufacturing process should be viewed, select “Manufacturing”. The mixture of 

the raw material in a manufacturer’s or downstream user’s formulation falls under the term 

“Formulation” . When selecting the lifecycle stage, please ensure that you comply with the REACH 

definition; otherwise, further descriptions of environmental scenarios can lead to incorrect assignment 

of release volumes.  

 

The decisive question in environmental risk assessment is whether the environmental entry by final 

users is carried out via a “point source”  or “wide dispersive”  distribution. Point source entries normally 

lead to more critical assessments due to higher local concentrations.  

 

The term “Service life” describes the use of substances in products from which the substances are 

intentionally released during use. A typical example of this is pigments in printer cartridges. Emissions 

which are generated during the waste stage of a substance are dealt with in “Waste Stage”. For 

substances which are used in products and which discharge effluents in accordance with the 

regulations, e.g. cosmetics, washing and cleaning products, the disposal is already included in the 

calculation if the Environmental Release Category (see ERC “Wide Dispersive Use” below) has been 

correctly assigned and must therefore not be taken into special consideration.  

 
In the column “Tonnage”, the amount of the substance must be entered for the according scenario. In 

the following, you will find several examples: 

 

- “Manufacturing”: The annual total manufacturing volume of a company at the biggest site 

in Europe.  

- “Formulation”: The annual total processed volume in the plant of formulation  

- “Final Use“ for consumer use is, strictly speaking, only the cumulated total annual volume 

of the individual manufacturer which is used for the specific application. If data is available, 

the cumulated total annual volume (for this application) of all European manufacturers and 

importers can be included in the underlying assessment. It is useful to include which of 
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both variations the scenario refers to in the title of the scenario, as ECHA may possibly 

sum up the individual volumes of manufacturers and importers.  

- “Final Use“ for final industrial use. The total annual volume that the (largest) user uses in 

his plant.  

- “Final Use“ for final professional use. “Tonnage” is the total annual volume which is 

continentally used for this scenario.  

  

It is also very important to select the correct reference under “Tonnage”  to achieve realistic 

assumptions. 

 
The field “Regional Tonnage” enables you to either assign 100% or only 10% of the total tonnage to 

an individual standard region (approx. 4000 km²). This data simulates the regional dilution effect for 

substances, which are not discharged at only one point in the environment. For industrial use, it is 

standardly assumed that there is only one plant as an emission source (factor 100%). The application 

of the standardized 10% rule is only possible for the steps “Formulation” and “Final Use” if it is sure 

that there is a corresponding homogeneous distribution of emission sources throughout Europe, i.e. if 

there are relatively many small or medium-sized customers with a wide regional distribution or if it 

involves consumer products with Europe-wide sales.    

 
In the field “Scenario Type” the assessment is selected that is either supported by a generic scenario 

(e.g. an ERC) or a specific scenario (spERC).  The ERCs are usually calculations in Tier 1 while 

spERCs indicate the Tier 2 level. spERCs should be used wherever possible as they represent 

significantly more realistic conditions. It is therefore necessary to determine whether the 

corresponding industrial associations have published spERCs in the meantime. 

 
About 120 scenarios are currently stored (as of 1 February 2010) in the field “spERC Industry Sector”. 

Industrial scenarios can be distinguished in that they are standardly connected with point source 

environmental emissions. Professional and consumer scenarios in the ERC system can be recognized 

by the term “wide dispersive use“ and are calculated on the basis of areawide environmental 

exposure.   

 
Only ERC1 can be selected in Tier 1 for the production of raw materials. The production of 

formulations is only depicted as ERC2 or ERC3 in Tier 1. Normally, the corresponding assignments of 

the ERCs regarding the relevant use have already been made available by industrial associations 

(“Description of use”). For many scenarios, however, industrial associations have also developed 

specific ERCs (spERCs), which are stored in EasyTRA and are available in the field “spERC”. 

spERCs are defaults on the Tier 2 level.  

Association-specific spERC scenarios can only be loaded if  

1) first, the corresponding generic ERC scenario has been selected 
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2) the relevant industrial sector in the field “spERC Industry Sector” is selected.  

3) and, in the following, the relevant spERC scenario is selected. 

During the last step, only those spERCs are displayed that fit to both the selected industry sector and 

the selected generic ERC scenario. 

 

EasyTRA aggregates all wide dispersive use exposures from all scenarios for one substance at the 

end. Therefore, it is important that volumes released to the environment are not double counted  or 

alternatives regarded as this may lead to a calculated higher environmental exposure that exceeds the 

volume that is actually manufactured. 

 

In the “Expert” mode, an internal spERC generator is available (see chapter 5.5.1) with which 

individual conditions can be programmed if the exposure conditions for a specific application from the 

stored spERCs cannot be reflected. Scenarios which are generated by the spERC Generator (see 

Chapter 5.5.1) can only be loaded if  

1) first, the corresponding generic ERC scenario is selected  

2) in the field “spERC Industry Sector”  the entry “User-defined spErC“ is selected 

3) and, in the following, the relevant spERC scenario is selected. 

During the last step, only those user-defined spERCs are displayed that are assigned to the selected 

genericERC. 

 

In the field “Sewage Treatment Plant”, the discharge of waste water via either a communal sewage 

treatment plant (indirect discharger) or a direct discharge of contaminated waste water in surface 

water must be selected. Normally, waste water in Europe is treated, i.e. the standard setting should be 

“Sewage Treatment Plant = Check”. 

 

Via the field “spERC”, the list of self-defined exposure scenarios which have been generated by the 

spERC Generator can be accessed.  

 

The button  can be found at the end of every line of the “Environmental Assessment” input mask, 

which enables you to enter Tier 3 defaults. Refer to Chapter 5.4.2 for details.  

 
Along with emission scenarios which define the release of the specified substance in the different 

environmental compartments, sediment, soil), the inherent characteristics of a substance also play an 

equally important role.  

 

The first step is to define the biodegradibility of a substance as this decisively influences the 

concentration of the substance in the environment (PEC = predicted environmental concentration). 
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 The biodegradability according to the rating criteria of the EU Guideline 67/548/EG or GHS 

Regulation (EG)1272/2008 is a mandatory entry and must be included (via drop-down menu). If data 

is available, EasyTRA also enables individual degradability rate entries in this mask for different 

compartments, which might lead to more advantageous elimination rates (see Chapter 5.5.1). 

 

 
 

The most valuable information regarding environmental exposure is, of course, the measured 

concentration in the environment. Especially in the the case of wide dispersive use of substances, the 

measured environmental concentration depicts the reality best. If you have representative 

measurement values, you can document them for every compartment in the Tier 2 box.. In these 

cases, EasyTRA calculates for regional (or alternatively local) emissions using your measurement 

values instead of with the simulated PEC values. 

 

 
 

The ECHA guidelines require that the maximum tonnage for an environment scenario must be 

included if the exact amount that is used in the individual scenarios is unknown (worst-case 

approach). This means that should there be a very high numbers of cases, the substance volume that 

is seemingly released into the environment is very much higher than the actually produced substance 

volume. This results in an unrealistic influence on local emissions with high case numbers as EUSES 

standardly adds both the regional proportion of emissions of all scenarios and the local emissions of 

the individual scenarios. The regional proportions of releases are actually small, but in the sum of 

many worst-case scenarios, the local release can easily be greatly exceeded. This is unrealistic and is 

only the result of the aggregation of tonnages of all scenarios.  

EasyTRA allows the restriction of background contamination to the actual worst case.  

Easy Tra assumes that the total annually produced substance is released into the regions in the 

course of a year. In those cases where the EUSES concentration is higher than the worst-case, the 

resulting regional concentration is added to the local release of a scenario instead of the EUSES 

aggregated regional concentration. As the worst-case is based on the calculated total volume of the 

produced substance, this value can never be exceeded in practice.  
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If you would like to use the EasyTRA approach instead of the EUSES approach, enter the maximum 

total releasable tonnage in the corresponding field of the Tier 2 settings. The deviating basis of 

calculation will be documented in the EasyTRA report. 

 

Further mandatory entries are the reference values of the specified substance. These so-called 

Predicted No Effect Concentrations (PNECs) are deduced from the available data regarding ecological 

toxicity. Please refer to the current ECHA “TECHNICAL GUIDANCE DOCUMENT FOR PREPARING 

THE CHEMICAL SAFETY ASSESSMENT” RIP 3.2-2, Chapter R.10 Environmental Hazard 

Assessment (especially Table R. 10-4 Assessment factors to derive a PNECaquatic) for further 

details. For a comprehensive environmental risk assessment, the PNEC values for all relevant 

compartments, i.e. sewage treatment (“Microorganisms in STP” which defines the chronic bacterial 

toxicity in sewage treatment sludge), freshwater, freshwater sediment, marine water, marine water 

sediment and soil should be available.  

 

 
 
The entry “Man via the environment“ secures the safe daily dosage for humans. Normally, it is 

identical with the oral reference value in the input mask “Human Health- Consumer”.  

 In the field “Anaerobic Degradation” you may enter data on the anaerobic degradation. Caution: This 

value only affects the aggregated exposure of all wide despersive use scenarios, but not on the 

exposure in local sediments. 

 

 
 

 

 
 
 
 
 
 
 
 
 
 

 



 
 

 
 
 

 
 Seite 28 von 34 
 

 

5.4.2 Tier 3 Assessments 
 

Tier 3 assessments are characterized by being customer or site specific.  

 

The button  can be found at the end of every line of the “Environmental Assessment” input mask. 

This button only appears if at least one field of the scenario has been filled in.  In order to carry out a 

Tier 3 calculation which deviates from defaults, a further input field can be opened. If the Tier 3 

settings have been activated, the button will turn red to make it visible directly in the scenario 

overview.  

 

The environmental 

assessment standardly 

assumes that the 

wastewater is discharged 

in a small communal 

sewage treatment plant  

(10,000 inhabitants) which 

lies on a small river (water 

flow rate 18,000 m³/day). 

These default values 

result in a dilution 

proportion of sewage 

treatment plant/river of 

1:10. On the Tier 3 level, 

specific dilution factors 

can be entered between 

the sewage treatment 

plant and the river the 

water is discharged into. For “wide dispersive use” applications, this is not possible.    

 

The calculation of marine exposure is standardly based on the assumption that the release of a 

substance by the manufacturer/user into the ocean occurs directly, possibly upstream of a sewage 

treatment plant. EUSES presets an unchangeable dilution factor of 100, which is very restrictive. The 

corresponding RCRmarinewatersedimenttherefore describes only local scenarios. The dilution effects for the 

release via a river or the actual dilution rate into the ocean is not taken into consideration. If you would 

like to calculate the wide (“regional”) effect on marine ecosystems while taking the dilution of a specific 

river into consideration, activate the selection box “New calculation Marine Dilution”. In this case, an 
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additional factor of 10 will be applied to the specific dilution of the river, which simulates the dilution of 

river water by the ocean.  Depending on the specific dilution factor for the river, you can achieve a 

higher total dilution this way than the EUSES standardly sets (Factor 100). If there are no specific 

values for the dilution by the river, the marine water factor remains at 100. 

Please observe that when “New calculation Marine Dilution” is activated a fundamentally different 

scenario is depicted compared to the normal RCRmarinewatersediment. 

 

EasyTRA allows you to differentiate between the release in fresh water or marine water if direct 

emissions to one of these compartments does not occur (e.g. because the affected treatment plant 

emits directly into the ocean and not via a river). By clicking the respective button you can disable the 

respective compartment. In this case only the regional emissions to the “disabeled” compartment are 

calculated. 

 

 
 

EasyTRA must standardly assume that all sewage sludge is taken to fields and meadows as fertilizer. 

Many sewage treatment plants, however, dispose of their sewage treatment sludge in a different way. 

On the Tier 3 level, you can modify the whereabouts of the sewage sludge to the real situation by  

taking the reduction of produced sewage treatment sludge into account accordingly. If the sewage 

sludge is, for example, completely burned, the value in the entry field would be entered with the value 

“100”. 

 

EasyTRA must standardly assume that the local emission is equal to the tonnage which you assign to 

the scenario in total (field: “Tonnage”) .  In most cases this is, however, a cumulative value and the 

total tonnage is actually distributed over many places in Europe. The setting “maximum local” tonnage 

enables you to correct the overestimation of the local emission. A reasonable size would, for example, 

be the annual accepted volume of your biggest individual customer. Please observe that this setting 

has no influence on scenarios with wide dispersive use. 

  

Important: As deviations from the defaults occur in Tier 3, which have been agreed upon between 

ECHA, EU member states and the industry, a justification absolutely must be saved as to why the use 

of Tier 3 standards are possible in this case. This justification is also output in the TRA report  and 

CSR and is a part of the required documentation. Therefore please only use the English language 
in this field.The justifications for the various Tier-3 measures are distributed among different tabs. 
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6 TRA-Report 
 
 
The button  enables you to generate a comprehensive report on the basis of the entered scenarios, 

which you can then save in a pdf format. Depending on the scope of the report, the output may take 

several seconds.  

 
The output language of the report can be selected in the 

selection box.  

 
The output language need not be the same as in the input module (see Chapter O). Only English and 

German are currently available as report languages.  

 
EasyTRA-generated reports may only be used by licensees. For this reason every EasyTRA Report 

includes a legal disclaimer and expressly names the licensee. For further information on the various 

types of licenses, please consult the EasyTRA webpage (www.easytra.de).  

 
The report is similarly structured as the EasyTRA input module. It contains the calculated exposure 

scenarios for the three REACH relevant target areas: Consumer, Worker, and Environment. In the 

environmental compartment, emission volumes which are safe with reference to the substance 

inherent characteristics are additionally reported. Msafe gives information on the substance volume 

which is safely discharged into sewage per day in kilograms. Due to the different environmental 

boundary conditions, different Msafe values result for the individual compartments due to the primarily 

emitted substance volumes. The lowest Msafe value is always decisive for safe use.  

 
Two appendices are included at the end of the report. Appendix I documents all of the entry values 

used. Individual entry values with justified deviations from TRA defaults are termed “Tier 2” or “Tier 3” 

(see above). Appendix II contains all of the defaults used and the calculation formulas. Appendix III 

documents programming errors in ECETOC® TRA 2010 (as of April 2010) that were corrected in 

EasyTRA. These changes lead to occasional deviations between ECETOC® TRA 2010 and EasyTRA 

risk assessments.  

 
The individual results for the target groups are subdivided according to the exposure route (oral, 

dermal, inhalatory) or compartment (freshwater, marine water, sediment, soil).  

 

The exposure for the different exposure routes and compartments, which is calculated by the 

EasyTRA entry values, is found in the unhighlighted fields of the report. The risk assessment 
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calculations (“risk characterization ratios” (RCRs)) are highlighted in color and are found to the right of 

these exposure values. These are calculated for every route and compartment by the quotient from 

exposure and the corresponding reference value. A RCR >1 

(highlighted in red) indicates that the reference values have been 

exceeded and the use is therefore unsafe, while a RCR<1 

(highlighted in green) indicates that the reference values fall 

below the prescribed limitation and are thus deemed safe. For 

humans, the total exposure from all routes is additionally 

assessed. 

The comparison between the default calculation and Tier 2 or Tier 3 calculations is particularly 

convenient. Here, you can immediately see how the Tier 2 or Tier 3 settings affect your scenario. If 

your scenario is not yet safe (=red), you can return to the input module and decide on new measures 

to make your scenario safe.  

 
RCRs, that are marked “-“ have no exposure via the individual routes /compartments.   
 
Certain parameter settings can, in rare cases, lead to conflicts in the calculation routine. These 

conflicts are marked in the TRA Report by the information “Check Input”. It is recommended to modify 

the scenario until the error message disappears.  

 
A directory of all the abbreviations used are found at the end of the report.  

 
You can generate an unlimited number of TRA Report versions, e.g. while you are optimizing 

scenarios. The Report Generator always calculates using the most current entry values. The “old” 

report versions remain as an independent document as long as EasyTRA (and, of course, the 

individual report) remains open.  
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Disclaimer: 
 

Although the greatest care was taken while programming EasyTRA, we do not assume liability for or 

guarantee the accuracy of the calculations of EasyTRA. 

 

Users of the software EasyTRA are fully responsible for their calculations. Jansen Systems GmbH is 

not liable for the use of EasyTRA.  

 

 

 

Change history: 
 

Update 1.02 

- Automatic amendment of complementary environment scenarios for existing 

worker/consuimer scenarios. 

- CSR generator. 

- Manual amendment of life cycle category “consumer“ when importing DUCC consumer 

scenarios without “consumer” flag. 

- Presetting standard gloves efficacy when importing DUCC scenarios.  

- Failure report for import of DUCC files 

 

Update 1.1 

- Generating missing environmental scenarios  

CSR Generator 

 

Update 1.2 

- Combination Exposures 

- Improved import functions for DUCC Scenarios  

- Error report for data import errors  

- Amend missing environmental scenarios automatically  

 

Update 2.0 

- Simultaneous calculation RCR 

- Introduction of Tier 2 modification “Anaerobic degradation“  

Adapted import function (efficacy gloves, advanced Import functions 
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Update 2.1 

 - Formula max. “tonnage to region” also takes ERC/SpERC settings into consideration 

 - Column “Scenario Subtitles” removed from environmental table 

 - Improved functionality: 

  - Drag and Drop 

  - Copy/Paste 

  - Only fill selected lines 

  - Column sorting function 

 - Introduction of selection boxes in import of scenarios from IUCLID Chapter 3.5 

 - Live calculation of all dependent environmental scenarios 

 - Introduction of Tier 2 setting “Measured Environmental Concentration” 

 - Introduction of Tier 2 setting “Substance in Preparation” for dermal exposure of workers 

 - Introduction of Tier 3 setting “Reduction of Sewage Treatment Sludge  Emission in Soil” 

 - Introduction of Tier 3 setting “Maximum Local Tonnage” 

 - Introduction of Tier 2 setting “Overwrite Standard Settings for Consumer” 

 - PC/AC generator for user-defined PC/AC 

 - Introduction of general comment field in data import 

 - Export of “unknown” Sector of Uses according to IUCLID 5.2 as descriptor “SU0” 

 - Differentiation between fresh and saltwater emissions in Tier 3 settings 

 - Introduction of Help function 

- Introduction of the function “Also Consider Max. Concentration in Substance in Preparation  

for Dermal Exposure” 

- Import of unfiled PC/AC 

- Additional data in IUCLID 5 export 
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